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Floating-Lizenzen

* Neue Floating-Lizenzen: Default DSLS. FlexNet weiterhin auf
Wunsch

* Dymola sucht beim Starten zunachst nach FlexNet-Lizenzen und

anschlieBend nach DSLS-Lizenzen.
DSLS-Lizenz-Nutzer missen nicht mehr via dymola.exe /DSLS

starten

e Zyklischer Lizenzserver-Check:

* Dymola pruft nun die Verbindung zum Lizenzserver alle 5

* erzwingt nach 4 vergeblichen Versuchen (d.h. 20 min), das
Programm zu schlieRen (mit der Moglichkeit, den aktuellen

Minuten

Arbeitsstand zu speichern).

* Bei instabiler Serververbindung empfehlen wir die

2022-12-15

Verwendung von Borrowing.

Neuigkeiten Dymola 2023x

X

: Dymola License Setup

General Details Borrow Setup
Type of license

O DSLS server

O DSLS nodelocked

® FLEXnet server

O FLEXnet nodelocked

License server

Server namefs) [LTXLG15 |

Port (optional) |E;-' default one of 27000-27009

Verify

Install license for all users

Install for all users (requires administrator rights)

Cancel

x

- Dymola

9 The connection ta the license server could not be automatically restored. Try to fix
any connection issues and click Retry to check again.

Otherwise, click Close to exit Dymola,




Angepasster Release-Cycle

NEW RELEASE LIFECYCLE

I

nt_2021

* One major release per year (autumn)

2 - Dymola 2023x ’ Dym0|a 2023

: - Dymola 2024x » Dymola 2023x

§ - And soon...

é  One maintenance release per year (spring)

g - Dymola 2023x Refresh 1

P Dzmola 2024x Refresh 1 » Dymola 2023x Refresh 1
» Dymola 2024x

>

p
" PS cATiA

75

DASSAULT
S54YSTEMES
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[y ¢
Scripting

* Die ModelManagement-Bibliothek ist nun auch im Python Interface integriert. So konnen z.B.
Modelle mit graphischen Modellkomponenten, Bedatungen (Modifier), Connections und
Annotations per Python-Scripting erstellt werden.

e Der Befehl Design.Experimentation.sweepManyParametersScatter hat nun das Argument "seed",
um eine Streuung der Punkte im Plot zu steuern (zur Vermeidung sich tberlagernder Punkte).
Bislang war dieser willklrlich gewahlt und nicht steuerbar.

2022-12-15 Neuigkeiten Dymola 2023x 5



Plots mit relativer Fenstergrofe

Im createPlot()-Kommando zum Erstellen von Plot-Windows kann die FenstergroRe nun auch
relativ zum aktuellen Dymola-GUI Fenster angegeben werden

Angaben im Range 0-1, statt bisher Pixel-genau).
createPlot (..,

position={x0, y0, width, height},

)

Zwei Fenster nebeneinander:
createPlot (id=1, ....,position={0.0, O, 0.5, 1});
createplot (1d=2,....,position={0.5, 0, 0.5, 1});

Ein Re-Sizing beim Andern der GroRe des Dymola GUI-Fensters erfolgt jedoch nicht.

2022-12-15 Neuigkeiten Dymola 2023x
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Variation struktureller Parameter in Sweeps

Strukturelle Parameter konnen bei folgenden Befehlen variiert werden:
simulateExtendedModel ()

simulateMultiResultModel ()

simulateMultiExtendedModel ()

Design.Experimentation.sweepParameter ()

Strukturelle Parameter sind solche, die das Gleichungssystem verandern (z.B. Anzahl der
Diskretisierungspunkte eines Fluid-Rohrs).

Dazu muss der Flag

Advanced.Translation.SmartSimulateExtended = true

gesetzt werden.

2022-12-15 Neuigkeiten Dymola 2023x
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L]
Beispiel Diskretisierungsstudie

Variable Browser g x Model View ‘7‘: Hi@ Him | Plot [1%] E@ ) G U I S
Variable Value Unit Descriptid ' HeatExchangerSimulation % + - 144 We e p
4 HEX.nNodes = 5 HEX.Q_flow_1// HEX.nNodes = 5 o k
T HXnNodes = 10 -8.80E3 HEX.Q_flow_1 / HEX.nNodes = 10 Pa ram ete rsS ann

HEX.Q_flow_1 // HEX.nNodes = 15

o203 HEX.Q_flow_1// HEX.nNodes = 20 e S n O C h n i C ht

N R * Workaround:
Befehl erzeugen
durch Sweep eines
| nicht-Strukturellen

T T
< > 0 40 80 120 160 200

-4 HEX.nNodes = 15
<4 HEX.nNodes = 20

-1.00E4+

-1.04E4+

QLfow 0 [ moesr Parameter, dann

X |RunScript ("c:/program files/dymola 2023x/insert/dymola.mos", true) ;

. .
= true -

8 e fi1e o . Im Skrlpt Befehl
Successfully loaded settings file C:/Users/LTXLG18/AppData/Roaming/DassaultSystemes/Dymola/2023x/setup.dymx

RunScript ("C:/Users/LTXLG18/0OneDrive - LTX Simulation GmbH/Dokumente/Dymola/startup.mos", true);

auf strukturellen

Advanced.Translation.SmartSimulateExtended=true;

Design.Experimentation.sweepParameter ( Pa ra l I I ete r

Design.Internal.Records.ModelDependencySetup (

Model="Modelica.Fluid.Examples.HeatExchanger.HeatExchangerSimulation",
dependencyParameters={Design.Internal.Records.DependencyParameter ( a n p a SS e n
name="HEX.nNodes",
values=linspace (5, 20, 4))},
integrator=Design.Internal.Records.Integrator (
startTime=0,
stopTime=200,
numberQfIntervals=500,
outputInterval=0,
method="Dassl",

tolerance=1le-05,
FivedStenSize=N11) -

‘Automatic re-translation of model triggered by changing structural parameter HEX.nNodes and having Advanced.Translation.SmartSimulateExtended=true;
‘ = true

2022-12-15 Neuigkeiten Dymola 2023x 8



X

Modelica Packages als Datei oder Ordnerstruktur

[7) Create New Package X

Name:

|MeinNeuesPackage|

Description:

U Partial

Extends:

| 2
Insert in package:

| ‘B D

[ Save contents of package in one file

Open new class In:

Do not open i

Cancel

= Flags and Variables

X

DefaultStore

@ | Non-Default

Name Value
v Advanced
v File
DefaultStoreAsOneFile []

Description

As default save packages in one file

Reset All Variables

Cancel

2022-12-15

Die Einstellung, ob eine Bibliothek als ein File oder in
der Ordnerstruktur gespeichert wird (,,Save contents
of package in one file"), wird global gespeichert,
bleibt also auch bei Neustart von Dymola bestehen
und wird beim Erstellen eines neuen Packages
defaultmaRig angewendet.

Die Einstellung erfolgt z.B. tiber die command-line via
Flag Advanced.DefaultStoreAsOneFile.

Neuigkeiten Dymola 2023x 9



Package Browser aufteilbar in Libraries/Projects

D@0+

Graphics  Document
@ =

Recent Back Forward Icon

Model
Package Browser

Model name...

: Dymola Commands
© Modelica Reference
@ Modelica
: Favorites
Unnamed
: Design
v : Dymola2023xDemo
P TestHighlightMatching
TestCheckLoop
: Vehiclelnterfaces

B e @

Libraries Package Browser Co

2022-12-15

DEE® 0o

Graphics  Documentatic

e » =

Recent Back Forward Icon | [

Model

Model name... <

: Dymola Commands
o Modelica Reference
7% Modelica
: Favorites

Design
: Vehiclelnterfaces

= 8 ¢ »

Projects

Model name... €

Unnamed
v : Dymola2023xDemo
P TestHighlightMatching
TestCheckLoop

f=. L @ »

Libraries Projects Components

Der Button Libraries in der unteren Menuleiste trennt den
Package Browser in editierbare und schreibgeschutzte
Bibliotheken auf.

Neuigkeiten Dymola 2023x
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Simulation Analysis — leichteres Setzen der Flags

% Rewind 4l Backstep T[;“: Die "Simulation Analysis" im Simulation Tab
Z Play Pause :d sep Forvard g bendtigt einige Debug-Flags, die vor der
' Animation Control Simulation gesetzt werden mussen.
= Simulston Ansysis x Wenn dies nicht erfolgt ist, weist Dymola beim
Simulation Analysis n.aquires onelor more of the bc?low options to be enabled. Sta rten der SImU|at|0n AnalyS|S NUN exp||2|t an
To enable further options or to disable them see Simulation>Setup>Debug. d|e 7U setzenden Emstellungen aus dem
Simulation Analysis options S| mu Iat|0 N Setu p h | n.

Events during initialization and simulation

Which states that dominate error

Provide variable dependencies and equation incidence
Generate block timers

Generate function and FMU timers

Confirm selection and simulate‘ | Cancel |

L]

2022-12-15 Neuigkeiten Dymola 2023x



Advanced-Einstellungen leichter erreichbar

Bisher:

Simulation

b License Options

mnent  Setup -
Tools

Tools

@

Version Help
Documents

p
Dymola

Website
Version Help

About
Dymola

Linear
Analysis ~
Custom

NeedsConversion = x *

[
= Options b

General Package Browser  Graphical Editor ~ Text Editor

General

Versior

Base font size 10 pt

Component browser
[1 Include non-graphical
Parameter dialog

[ show final parameters

Command window

[1 Highlight all matches

Variables... OK

X

g

2022-12-15

Jetzt auch direkt:

DREY*OO-

Dymola - Dynamic Modeling Laboratory - [Di

Graphics Documentation Text

To Clipboard Image Animation HTML Graph

Export

Package Browser

Model name..

Simulation Tools
2 & @ @
Library Licens¢ | Options | Version Help Dymol
Management  Setup v - Cocuments  Websit
Tools £+ Options... Help
Variables... b4 +
« = [¥]l

Dymola Commands

= Flags and Variables

? X

filter variables ‘ Non-Default
Name Value Description
v Advanced
v Editor
ActivateSmartRename 3 Updates other classes when renaming componen...
MaxLineLength 280 The maximum length of lines for automatic form...
v FMI
FMUFMIType "csSolver” What type of FMI: me, cs or all
FMUFMIVersion "2" FMI version
~ Plot
FilesToKeep 3 Number of results to keep
v Legend
Filename Include filename in plot legend. Can be changed ...
Frame Draw frame around plot legend by default. Can b...
Horizontal O Horizontal layout of plot legend by default. Can b...
Location 5 Default location of plot legend (1-7). Can be cha...
Transparent O Draw plot legend with transparent background. ...
MeasurementTime Display the current time in the measurement cur...
v Scripting
‘ChangeToDirectory O Change to script directory before running script
~ Simulation
SwitchToSimulation Switch to the Simulation tab when starting a sim...
v Translation
EnableCodeExport Enable code export
v Generate
VariableDependencies Generates local dependency in XML file
v Log
NonLinearIterationVariables During translation log the non-linear iteration var...
‘OutputCPUtime Include a variable for elapsed CPU time during si...

Reset All Variables

Cancel

Neuigkeiten Dymola 2023x
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Resources Handling

Verbesserte Behandlung von Nicht-Modelica-Dateien beim Kopieren von Bibliotheken:
* Flag Advanced.Editor.CopyResources = true

e Externe Dateien (z.B. Tabellendaten), die mit loadResource, IncludeDirectory,
LibraryDirectory oder als Bilder im Modell eingefligt sind (und typischerweise im Resources-
Unterordner des Package-Ordners abgelegt sind), werden beim Kopieren mitkopiert.

e Referenzen ohne diese Stichworter (z.B. in der Dokumentation) werden nach wie vor nicht
mitkopiert.

2022-12-15 Neuigkeiten Dymola 2023x 13



m " Functional
[ Mock-up
e |Nterface

FMI 3.0 fur Import und Export

Der FMI 3.0 Standard wird nun fur den Import und Export von FMUs unterstitzt.

Es werden die neuen Strukturen und Namen verwendet, allerdings sind noch keine neuen
Features aus FMI 3.0 implementiert.

An folgenden Features aus FMI 3.0 wird als nachstes gearbeitet:
* Array variables
* Terminals and icons
* Early return from co-simulation at event

Weitere Infos zu FMI 3.0 finden Sie hier:
https://fmi-standard.org/assets/FM| 3.0 Press Release.pdf

2022-12-15 Neuigkeiten Dymola 2023x
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https://fmi-standard.org/assets/FMI_3.0_Press_Release.pdf

SSP - System Structure & Parametrization — Wozu?

Standardisiertes Container-File-Format a) System Structure
(ZIP) zum Abspeichern von: - Simulationsarchitekturen mit Hierarchie und Schnittstellen

b) Parametrization

- Verschaltung von FMUs

Mehrere Datensatze fiur 1
FMU

Datensatze an mehrere
FMUs verteilen

“System Structure and Parameterization (SSP) is a tool independent standard to
define complete systems consisting of one or more FMUs including its
parameterization that can be transferred between simulation tools.”

2022-12-15 Neuigkeiten Dymola 2023x
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Seit Dymola 2023: User Meta Data

NRE» con-

m Graphics
B @ »

Documentation Text

Simulation Tools

E <> % RevisionEditor <>HTML

3[@ @ Delete A& = Q,

info infa <> pevision Source Markdown = Duplicate (Default)
Recent Back Forward Formatted Info Info Cut Copy Paste Find Replace Go
- Editor  Source Meta Data I Select All Ta 6
Model Layer Language Clipboard Find
Package Browser F X -
?
Model name... [7e]=]| ™ Dymola ? X
D Dymola Commands User meta data of Unnamed1.
© Modelica Reference I Key ] Description 2
) 1 Author* Leo Gall
@ Modelica
D Favorites 2 Organization* LTX Simulation GmbH
Unnamed 3 Contact leo.gall@ltx.de

£ TIL 4 CreationDate* a
«2» TILMedia 5 CreatedInProject UPSIM 2022
(») MetaDataTest 6 ModifiedDate 2022-03-07
‘ Unnamed1 7 Copyright 2022

8 License BSD 3-clause

9 ModelicaTool Dymola

v
Read Template Cancel
T~ e i

[ MetaTempiate1 tat E3

1

W O~ oy O W N

14

16
17

Author*
Organization*
Contact
CreationDate*
CreatedInProject
ModifiedDate
Copyright

License
ModelicaTool
ModelicaToolVersion
ModelicaLanguageVersion
MSLVersion
CopiedFromModel

Leo Gall
LTX Simulation GmbH
leo.gall@ltx.de

UPSIM 2022

2022

BSD 3-clause

Dymola

2023

3.5

4.0.0 (shipped with Dymola)

Modelica.Electrical.Machines.Examples.Transformers.Rectifierépulse

CopiedFromModelVersion
CredibilityLevel
Checked

CheckedBy

2022-12-15

4.0.0
0
false

I (») MetaDataTest x +
Test meta data and SSP support in Dymola 2023-beta.1

Information

Test example with polyphase components:
Star-connected voltage source feeds via a transformer a diode bridge

rectifier with a DC burden.

L

Using f=50 Hz, simulate for 0.1 seconds (5 periods) and compare voltages and currents of source and DC burden, neglecting initial transient.

Extends from Modelica.lcons.Example (Icon for runnable examples).

Parameters

Type Name Default Description
Voltage v 100*sqrt(2/3) Amplitude of star-voltage [V]
Erequency f 50 Frequency [Hz]
Resistance RL 0.4 Load resistance [Ohm]
Capacitance C 0.005 Total DC-capacitance [F]
Voltage VCo sqri(3)*V Initial voltage of capacitance [V]
TransformerDataltransformerData1|transformerData1(C1=Modelica...| Data of transformer 1

User meta data

Key Description
Author Leo Gall
Organization LTX Simulation GmbH
Contact leo.gall@ltx.de
CreationDate 2022-03-07
CreatedInProject UPSIM 2022
ModifiedDate 2022-03-07
Copyright 2022
License BSD 3-clause
ModelicaTool Dymola
ModelicaToolVersion 2023-beta.1

ModelicaLanguageVersion 3.5

MSLVersion 4.0.0 (shipped with Dymola)

CopiedFromModel Modelica.Electrical. Machines.Examples.Transformers.Rectifier6pulse
CopiedFromModelVersion |4.0.0

CredibilityLevel 0

Checked false

CheckedBy

Name: MetaDataTest
Path: MetaDataTest

Filename: C:/LG/Arbeit/Projekte/K20014-UPSIM/41-Modelle/ModelicaMetaData/MetaDataTest.mo

Uses: Modelica (version="4.0.0")

model Unnamedl
annotation (

Icon (coordinateSystem(preserveAspectRatio=£false)),
Diagram(coordinateSystem(preservelAspectRatio=false)),
~ Dymola UserMetaData={{"Author*","Leo Gall"}, {"Organization*","LTX Simulation GmbH"}, {"Cor

- "2023"}, {"ModelicalanguageVersion","3.5"}, {"M5LVersion","4.0.0

end Unnamedl;

Neuigkeiten Dymola 2023x
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16



© Dassault Systémes | Confidenfial Information | 23/07/2021 | ref.: 3D8_Document_2021

SSP SUPPORT

 Multiple sections of meta data

- Creation of multiple (named) categories of meta data
- Reads SRMD meta data files in SSP extra directory

* Supports composite Modelica types

- E.g. voltage or a rotational flange
- Encoded as SSC::Binary type in SSP

* mime-type = “x-Modelica”

= source = “absolute model path”

>
7 PS cATiA

Dymola *
lJser meta data of DC_Motor.DC_Motor,
Category: | Simulation Resource Meta Data (Stimuli.srmd) “||T ||| [
Key Description ~

1 desetlevelsrmdimodel-meta-data=

2 model.type phiysical principle

2 physical-principlefarn iky ex: basic

4  physical-prindplename ex: Stimuli

5 physcical-principle.technelogy eyt constant

& physical-princpletechnology.variant [

7 modelmanufacturer GlueParticle

€ 3 ’
Read Template Cancel

2
DS Sdsrérvies

2022-12-15 Neuigkeiten Dymola 2023x
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Ausblick mit Bitte um Feedback

FEATURES UNDER DEVELOPMENT

Features that have been recently developed and need testing

« Translation warning when reversing causality (signal blocks) continuousClock
L
Advanced.Beta.CheckLoopCausality=true :\\_i_}______L__{.. add
- - +1
i Y
M System of equations with causal connection variables, this is normally not intended. starmrlne=us \;G)_‘}‘
Causal connection variables: +1
add.y
ain. gain

« Highlight good end-points when starting a connection
k=2

©® Dassault Systémes | Confidential Information | 23/07/2021 | ref.: 3DS_Document_2021

- Highlights suitable target connectors when you start drawing a
connection
Advanced.Beta.HighlightMatchingConnectors=true

E?S DASSAULT

P
12 28 CATIA SYUSTEMES

Advanced.Beta.CheckLoopCausality = true
Advanced.Beta.HighlightMatchingConnectors = true

2022-12-15 Neuigkeiten Dymola 2023x
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Beispiel Advanced.Beta.HighlightMatchingConnectors = true

controlBus

Advanced.Beta.HighlighMatchingConnectors = true

Eﬂ_m W_g_um_ [
S| o G

2022-12-15

E " chassis |

Neuigkeiten Dymola 2023x
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Dymola & Modelica Standard Library

Dymola Version
Dymola 2023x
Dymola 2023
Dymola 2022x
Dymola 2022
Dymola 2021x
Dymola 2021
Dymola 2020x
Dymola 2020
Dymola 2019 FDO1
Dymola 2019
Dymola 2018 FDO1
Dymola 2018
Dymola 2017 FDO1
Dymola 2017
Dymola 2016 FDO1
Dymola 2016
Dymola 2015 FDO1
Dymola 2015
Dymola 2014 FDO1
Dymola 2014
Dymola 2013 FDO1

MSL Version
4.0.0
4.0.0
4.0.0
4.0.0
4.0.0
3.23
3.2.3
3.2.3
3.2.2
3.2.2
3.2.2
3.2.2
3.2.2
3.2.2
3.2.1
3.2.1
3.2.1
3.2.1
3.2.1
3.2
3.2

MSL Version Release Date # Models/Blocks # Examples
4.0.0 2020-06-04 1417 512
3.2.3 2019-01-23 1288 404
3.2.2 2016-04-03 1600 *
3.2.1 2013-08-14 1360 *

3.2 2010-10-25 1280 *
3.1 2009-08-14 923 *

X

# Functions
1219
1227
1350
1280
910
615

* # Examples war in # Models/Blocks enthalten

Neuigkeiten MSL 4.0.0:

http://www.ltx.de/download/molib/MSL4.0.0 Neuigkeiten LTX.pdf

Aktuelle Maintenance Release fiir MSL 3.2.3:
MSL v3.2.3+build.4 (2020-06-04)
https://github.com/modelica/ModelicaStandardLibrary/releases

Neuigkeiten Dymola 2023x

20


http://www.ltx.de/download/molib/MSL4.0.0_Neuigkeiten_LTX.pdf
https://github.com/modelica/ModelicaStandardLibrary/releases

Modellbibliotheken

Keine neuen Modellbibliotheken in dieser Version.

Details zu Verbesserungen bestehender Bibliotheken gerne auf Anfrage!

2022-12-15 Neuigkeiten Dymola 2023x
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AlternativeVehicles

Belts

BG_RT

EDrives

EWITAC

FlexibleBodies

PowerTrain

Statistics

TIL

Visualization

2022-12-15

Electromechanical Actuators in multiple modeling levels - new

Hybrid Vehicle Power Trains, Battery-Electric and Fuel-Cell Vehicles Lw

Static and Dynamic Analysis of Belt Drive Systems

Modelica Libraries
Catalog

Version 7

Real-Time Simulation with Standard DAQ Cards

Modular, Multi-phase Controlled Electric Drives

Grid-connected Elastic Wind Turbines - new

Flexible Beams, Annular Plates and general FE-based Bodies

Human Comfort within Air-Conditioned Zones - enhanced

Heating and Cooling Systems in Buildings - enhanced

Incompressible Thermo-Hydraulic Fluid Systems

Vehicle Power Trains and Planetary Gearboxes with Losses

Definition of Statistical Variations of Parameters and Variables

Stationary and Transient Simulation of Thermodynamic Systems - new ;

Advanced, Model Integrated, Offline and Real-Time Visualization http://www.ltx.de/download/Modelica Libraries Catalog LTX.pdf

Neuigkeiten Dymola 2023x 22



http://www.ltx.de/download/Modelica_Libraries_Catalog_LTX.pdf

C-Compiler

e Visual Studio 2022 wird nun unterstiutzt

* FMU-Erstellung kann auch via Verify Compiler geprift werden
* GCC:

MinGW GCC compiler

Dymola 2023x has limited support for the MinGW GCC compiler. The following versions
have been tested and are supported:

X

e For 32-bit GCC: version 6.3 and 8.2
e For 64-bit GCC: version 7.3 and 8.1

= Simulation Setup

. . General Translation Output Debu Compiler Realtime FMI Export
Hence, at least the versions in that range should work fine. i J P P

C compiler

FMI Import

21 Visual Studio 2012/Visual C++ 2012 Express Edition (11.0)
! Visual Studio 2015/Visual C++ 2015 Express Edition (14.0)
) Visual Studio 2017/Visual C++ 2017 Community (15)
@ Visual Studio 2019/Visual C++ 2019 (16)

Visual Studio 2022/Visual C++ 2022 (17)

) Visual Studio Custom
C:/Program Files (x86)/Microsoft Visual Studio/2019/BuildTools/VC/Auxiliary/Build

) MinGW GCC

) Linux cross-compiler (WSL)

| C:/Windows/System32/wsl.exe

Verify Compiler  [] Verify also FMU export on success

2022-12-15 Neuigkeiten Dymola 2023x
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Nachste Kurstermine

e Kurs vor Ort in Munchen , Einfiihrung zu Dymola und Modelica“
23.-24. Mai 2023 | 07.-08. November 2023

. OnlineI-Kurs an jeweils vier Vormittagen ,Multidisziplindare Modellierung und Simulation mit Modelica und
Dymola“
07.-10. Marz 2023 | 26.-29. September 2023

e Kurs ,DLR Visualization Library und Modelica MultiBody“
Auf Anfrage

e Kurs ,Einfiihrung zu OpenModelica“
Auf Anfrage

e Spezialkurse auf Anfrage, z.B.: Performance-Workshop, Git&Modelica, FMI&FMPy
Kursthemen fir fortgeschrittene Anwenderlnnen:
https://www.ltx.de/download/Kurs/Kursthemen-Fortgeschritten.html

Aktuelle Termine unter www.kurse.ltx.de
Anfragen und Anmeldungen gerne unter: kurse@Itx.de

2022-12-15 Neuigkeiten Dymola 2023x 24
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Release Notes .
® 8 = Q Q@ e N MOO® = R R@AT O Y

Online:

https://Itx.de/download/Dymola/ReleaseNotes Dymola2023x.pdf Dymola

Dynamic Modeling Laboratory

Dymola Release Notes

Dymola:

Help > Documentation > Dymola release notes

Dymola 2018

Flinfteiliges Handbuch als ein PDF (fiir Suche):
https://Itx.de/download/Dymola/DymolaFullUserManual Dymola2023x.pdf
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Download flir Wartungskunden

www.ltx.de/download/Dymola/aktuell

www.ltx.de/download/Dymola/Dymola2023x

Noch keine Login-Daten?
Schreiben Sie an support@ltx.de

Datei Bearbeiten Ansicht Chronik Lesezeichen Extras Hilfe

- O X
[
Dymola 2023- Download Info x +
& C QO B httpsy//www.ltx.de/download/Dymola/Dymola2023.html B 9% 3=
X Mia pijSx @Wiafui? @WennWia OAcadem @Supp @Partner\nfo W gl Ogh/mo Ogh/mo/back OMSL > [ Weitere Lesezeichen

X

Dymola 2023 - Download Info

Wartungskunden erhalten neue Dymola-Versionen kostenfrei zur Verfiigung gestelit.
Versionsinfo

Der Download enthalt Version Dymola 2023, Build Date 2022-04-13

LTX-Webinar

Highlights von Dymola 2023 als PDF
Highlights von Dymola 2023 als Video
Vollstdndige Release Notes
Installationsanleitung

a) Download von Dassault Systémes

Falls Sie bereits tber einen "DS Passport" verfugen (d.h. Zugangsdaten aus vorherigen Media Orders), kdnnen Sie Updates direkt vom Hersteller
herunterladen:

Software-Portal bei Dassault Systémes.
Sie finden Dymola dort in der Kategorie "CATIA".

b) Download von LTX

Windows

Download Dymola 2023 for Windows

Dateigrofe: 1.083.941.604 Bytes (1,0 GB)

SHA1 Checksum: f04d28a93488597284098d4ee257cf7be930c96
MD5 Checksum: 86e979d472¢1972c7cf29fce0b3bd163

Linux

Download Dymola 2023 for Linux

DateigréRe: 946.069.153 Bytes (903 MB)

SHA1 Checksum: 22a0665dcfd570f9cb15157c23ac5ff2ccaa0947
MD5 Checksum: 5ef72a356fa9136fa6f0ca27a59af84c

Zugangsdaten

[a)
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IX
Modelica Conference 2023

9.-11. Oktober 2023 in Aachen 15[11 ode I Ica

Conference
The 15th International Modelica
Conference

Call for Paper kommt bald hier: Aachen, Oct 9-11, 2023

https://2023.international.conference.modelica.org
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ILRX
Kontakt

sales@ltx.de — Vertriebsanfragen, Wartungsangebote&-Rechnungen, Lizenz-Keys

support@Itx.de — Technischer Support (SR), Verbesserungsvorschlage (ER)

LTX Simulation GmbH

Wohlfartstralle 21b
80939 Minchen
Deutschland

Tel.: +49 89 20 97 00 55
leo.gall@ltx.de
www.ltx.de

Right click icon made by Freepik from www.flaticon.com
Double click icon made from http://www.onlinewebfonts.com/icon is licensed by CC BY 3.0
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